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Patch 147 Overview 
 

This patch will avoid errors in Image Processing caused by some encapsulated 
PDFs that do not follow the DICOM standard and improperly include the Pixel 
Padding Value (0028,0120) data element.  This results in an “<UNDEFINED>” 
error and interrupts the processing of the DICOM encapsulated PDFs.  The patch 
allows for the processing of these objects. 

NOTE:  All sites running VistA Imaging 3.0 that have implemented DICOM 
Gateways must install the updated DICOM Gateway software on all 
DICOM Gateway systems. 

Distribution of Software 
To obtain MAG*3.0*147 files, use the File Transfer Protocol (FTP) to retrieve 
MAG3_0P147.RTN from one of the following OI Field Offices' 
ANONYMOUS.SOFTWARE directories: 
 
OI Field Office  FTP Address    Directory 
--------------------  -----------------    ------------- 
Albany    ftp.fo-albany.med.va.gov   anonymous.software 
Hines    ftp.fo-hines.med.va.gov  anonymous.software 
Salt Lake City   ftp.fo-slc.med.va.gov   anonymous.software 
 

Patch Contents 

This patch includes the following files. 

Software 

MAG3_0P147.RTN – Routine set to be installed on the DICOM Gateway. 

MAG3_0P147.KID – KIDS (Kernel Installation and Distribution System) 
package to be installed on the VistA hospital database.  
 

Documentation  

MAG3_0P147_Patch_Description.pdf – The release build of this patch can 
be downloaded from the FTP folder.  Installation instructions are included 
in this document.  
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Associated Patches 

Before MAG*3.0*147 can be installed, the following considerations need 
to be made: 

• This patch must be installed on a MAG*3.0*53 or later legacy 
DICOM Gateway.  

• This patch MAY NOT be installed on a MAG*3.0*138 test 
DICOM Gateway. 

Test Sites 
The following sites are test sites for this patch: 

• Hines. IL Medical Center  
• Southern Arizona HCS – Tucson, AZ 

 

Remedy Calls 
The following Remedy help desk calls are addressed in this patch: 

Ticket # 
962507 

- Site unable to import non-DICOM standard encapsulated PDF; 
2-3 window errors out with encapsulated PDF. 

Ticket # 
968973 

- DICOM Gateway is getting an error when importing non-
DICOM standard encapsulated PDF. 

 

NSRs 
There are no National Service Requests (NSRs) addressed in this patch. 
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Patch 147 Changes 
 
The MAG*3.0*147 patch will enable the sites to process DICOM encapsulated PDFs that 
do not conform to the DICOM standard and include the Pixel Padding Value (0028,0120) 
data element. 
 

Security Keys 
There are no new or modified security keys in this patch. 
 

Remote Procedure Calls 
There are no new or modified Remote Procedure Calls in this patch 
 

Menu Options 
There are no new menu options in this patch. 
 

Data Dictionaries 
There are no new or modified menu options in this patch. 
 

Routines  

VistA Routines 

This section lists new and modified Imaging routines for the VistA system.  For 
each routine, the second line will contain the following information. 
 
;;3.0;IMAGING;**147**;Mar	  19,	  2002;Build	  3	  	  
 
Please note that the “before” checksum may differ if any test software has been 
installed.  Checksum values are calculated using the kernel utility program, 
CHECK1^XTSUMBLD. 
 

Routine	  Name	   Checksum	  Before	   Checksum	  After	   Patch	  List	  

MAGIP147	   N/A	   4110425	   **147**	  

 
Routine MAGIPS147 is an installation routine that is automatically deleted after 
the KIDS installation. 
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DICOM Gateway Routines 

This section lists new and modified Imaging routines for the DICOM Gateway 
system.  Please note that the before checksum may differ if any test software has 
been installed.  Checksum values are calculated using the kernel utility program 
CHECK1^XTSUMBLD. 

Routine	  
Name	  

Checksum	  
Before	  

Checksum	  
After	  

Patch	  List	  

MAGDDW2	   52530205	   52939671	   **10,	  30,	  51,	  54,	  53,	  147**	  
MAGDDR2	   32387608	   32693504	   **10,	  11,	  30,	  54,	  147**	  
MAGDVRSN	   21494340	   24194340	   **1,	  7,	  9,	  26,	  21,	  10,	  36,	  3,	  

11,	  30,	  5,	  51,	  50,	  52,	  69,	  
75,	  102,	  103,	  54,	  53,	  66,	  
49,	  99,	  123,	  118,	  147**	  
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Installation 
 

Installation Planning 
When planning the installation of MAG*3.0*147, consider the following factors: 

• This patch is to be installed on the DICOM Gateways and VistA.  Installing the 
routines on this system will take less than five minutes.  

• Users should not use the DICOM Gateways during installation.  All gateway 
operations should be suspended at this time. 

Review all installation instructions in this document before beginning the installation 
process. 

 

Installation Prerequisites 

NOTE: All released VistA Imaging patches must be installed on the VistA system 
before installing MAG*3.0*147.  

Users can download the patch installation files from the OI Field Offices’ Anonymous 
Software directories.  All instructions in this section assume that the distribution files for 
this patch have been copied to a local storage location.  For the list of distribution files for 
this patch, see page 1. 

 

KIDS Installation 

KIDS Package Installation Steps 

The KIDS installation will take less than one minute. 
 
1    Important: Before installing the KIDS, perform the following steps for each DICOM 
Gateway: 

a. Stop each process (use CTRL+C if needed) in each active process/telnet window. 
(Note that clicking only closes the window; it does not stop the process). 

b. Navigate to the main DICOM Gateway menu and enter “5” (Quit). 
c. Ensure that Caché is running.  (When Caché is running, the Caché cube in the 

Windows taskbar is blue, not grey.) 
 

2    On the VistA system, access the Kernel Installation and Distribution System Menu 
[XPD MAIN]. 
 
3    Run the Installation option [XPD INSTALLATION MENU]. 
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4    Load the KIDS file by performing the following step: 

a. Run the Load a Distribution option [XPD LOAD DISTRIBUTION] to 
load the KIDS distribution. 

b. When prompted, enter the path and file name (MAG3_0P147.KID) of the Patch 147 
KIDS file. 

c. When prompted to continue with the load, enter YES.  A Distribution OK! 
message will be displayed when the load is complete. 
 

5    After loading the KIDS file, use the following options to verify the contents of the 
patch and to back up any affected routines. 

a. Verify Checksums in Transport Global [XPD PRINT 
CHECKSUM] – Run this option to ensure the integrity of the routines in the patch.  

b. Compare Transport Global to Current System [XPD COMPARE 
TO SYSTEM] – Run this option to view all changes that will be made when the 
patch is installed.  All components (routines, options, and so on) in the patch will 
be compared. 

c. Backup a Transport Global [XPD BACKUP] – Run this option to 
create a backup message of any routines exported with the patch.  It will NOT 
back up any of the other changes. 
 

6    After performing the load and any optional verification steps, install the KIDS file by 
performing the following steps: 

a. Run the Install Package(s) [XPD INSTALL BUILD] option. 
b. When prompted for the install name, enter MAG*3.0*147. 
c. Answer NO to the following prompts: 

 
 

Want KIDS to Rebuild Menu Trees Upon Completion of Install? NO// 
Want KIDS to INHIBIT LOGONs during the install? NO// 
Want to DISABLE Scheduled Options, Menu Options, and Protocols? NO// 
 

 

7    When installation is finished, an Install Complete message will be displayed. 
 
8    Restart the DICOM Gateways and associated processes. 
 

KIDS Installation Example 

The sample below illustrates the installation of MAG*3.0*147. 
 
	  
Select	  Installation	  Option:	  6	  	  Install	  Package(s)	  
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Select	  INSTALL	  NAME:	  MAG*3.0*147	  	  	  	  	  	  5/1/14@20:03:24	  
	  	  	  	  	  =>	  MAG3_0P147	  	  ;Created	  on	  Feb	  11,	  2014@05:43:11	  
	  	  
This	  Distribution	  was	  loaded	  on	  May	  01,	  2014@20:03:24	  with	  header	  
of	  
	  VistA	  Imaging	  V3.0-‐	  Patch	  147	  ;Created	  on	  Feb	  11,	  2014@05:43:11	  
	  	  	  It	  consisted	  of	  the	  following	  Install(s):	  
	  	  	  	  MAG*3.0*147	  
Checking	  Install	  for	  Package	  MAG*3.0*147	  
	  	  
Install	  Questions	  for	  MAG*3.0*147	  
	  	  
	  	  
	  	  
Want	  KIDS	  to	  INHIBIT	  LOGONs	  during	  the	  install?	  NO//	  
Want	  to	  DISABLE	  Scheduled	  Options,	  Menu	  Options,	  and	  Protocols?	  
NO//	  
	  	  
Enter	  the	  Device	  you	  want	  to	  print	  the	  Install	  messages.	  
You	  can	  queue	  the	  install	  by	  enter	  a	  'Q'	  at	  the	  device	  prompt.	  
Enter	  a	  '^'	  to	  abort	  the	  install.	  
	  	  
DEVICE:	  HOME//	  	  	  HERE	  
	  	  
	  	  
	  Install	  Started	  for	  MAG*3.0*147	  :	  
	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  May	  01,	  2014@20:03:47	  
	  	  
Build	  Distribution	  Date:	  Feb	  11,	  2014	  
	  	  
	  Installing	  Routines:..	  
	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  May	  01,	  2014@20:03:47	  
	  	  
	  Running	  Post-‐Install	  Routine:	  POS^MAGIP147.	  
	  	  
Post	  Install	  Mail	  Message:	  May	  01,	  2014@20:03:47	  
	  	  
	  Updating	  Routine	  file......	  
	  	  
	  Updating	  KIDS	  files.......	  
	  	  
	  MAG*3.0*147	  Installed.	  
	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  May	  01,	  2014@20:03:47	  	  
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DICOM Gateway Routine Installation 

Routine Installation 

Users should not use the DICOM Gateways during installation.  Installation will take less 
than five minutes on each DICOM Gateway. 
  

1 The MAG3_0P147.RTN files must be transferred to the DICOM Gateways.  
Create a C:\MAGPATCHES\P147\M\ directory on the DICOM Gateway and 
place the MAG3_0p147.RTN file in the directory. 

 
2 After the routine file is placed on the DICOM Gateway, the user should open the 

Caché Studio from the Caché cube located on the taskbar. 
 

3 From the Caché Studio window, the user should open the File menu located on 
the Studio toolbar and select the Change Namespace option.  The user should 
verify that the DICOM namespace is highlighted.  If not, the user should select 
the DICOM namespace and click OK.  

 

 
 

4 Prior to installation, the user should backup up the original routine files 
(MAGDDR2.INT, MAGDDW2.INT, MAGDVRSN.INT) with the following 
steps:   
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a. From the Caché Studio window, the user should open the Tools menu 
located on the Studio tool bar and select the Export option on the menu.  
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b. First, select routine	  MAGDDR2.INT in the default Export in the XML 
format setting.  (Make sure the location is set to Export to LOCAL file.) 
Enter the destination folder "C:\MAGPATCHES\P147\M\" and change to 
the filename to MAG3_0P147BACK.XML. 

 

 
 

c. Select Add and select the MAGDDR2.INT routine.  
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d. Press “Open.” 
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e. Then, select Add and select the MAGDDW2.INT routine.  
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f. Press “Open.” 
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g. Then, select Add and select the MAGDVRSN.INT routine. 
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h. Press Open. 
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i. Press OK to create the XML routine backup. 
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5 Next, to install the new MAG3.0P147 routine from the Caché Studio window, the 
user should open the Tools menu located on the Studio toolbar and select the 
Import Local option on the menu. 
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6 The user should navigate to and then select the MAG3_0P147.RTN file located 
on the DICOM Gateway at C:\MAGPATCHES\P147\M, and then press the Open 
button. 

 

 
 

7 Make sure that the Compile Import Items option is checked and press the 
OK button. 
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8 The patch routines have now been applied to the DICOM Gateway.  The user may 
now close the Caché Studio window (and start the gateway process again).  The 
following screen shows that the compilation has finished successfully. 

 

 
 

Restoring the DICOM Gateway 

If the original state of the DICOM Gateway should have to be restored, perform the 
following steps: 
 

1 The user should open the Caché Studio from the Caché cube located on the 
taskbar. 

2 From the Caché Studio window, the user should open the Tools menu located on 
the Studio toolbar and select the Import Local option on the menu. 
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3 The user should select the 
C:\MAGPATCHES\P147\M\MAG3_0P147BACK.XML file located on the 
DICOM Gateway and then press the Open button. 

 

 
 

4 Make sure that the Compile Import Items option is checked and press the 
OK button. 
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5 The backup routines have now been restored on the DICOM Gateway.  The user 
may now close the Caché Studio window. 

 


